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MS Front Page 2003 
 
СЪЗДАВАНЕ НА НОВА СТРАНИЦА В FRONTPAGE 
След като отворите програмата FrontPage, за създаване на нова страница  
изберете:  
File -> New-> Page or Web -> Blank Page 

Или най-добре изберете тази икона . 
СМЯНА НА ЦВЕТА НА ФОНА 
File-> Properties-> Появява се прозореца Page Properties-> Background-> Colors->  Background-> изберете 
желания цвят за фон на вашата страница->OK 
* По-бърз начин за достигане до Page Properties е: 
десния бутон на мишката(върху фона)-> Page Properties 
ПОСТАВЯНЕ НА КАРТИНКА КАТО ФОН 
File-> Properties-> Появява се прозореца Page Properties-> Background->Formatting-> поставете отметка 
на Background picture->Browse-> Изберете желаната картинка като стигнете до нея. 
DEFAULT TARGET FRAME 
Вашият сайт може да бъде изграден от няколко рамки(Frame).Да предположим че сте създали на сайта 
си три рамки: лява, дясна и горна. На горната рамка  
сте си направили навигационни менюта и искате след като изберете нещо,  
препратката да се отваря в дясната рамка, а не в същата. За тази цел  
направете: 
File-> Properties-> Появява се прозореца Page Properties-> General->Default target 

frame-> изберете тази икона -> Current frames page(изберете желаната  
рамка в която  да се отвори препратката)->OK 
* Ако искате препратката да се отвори в нов прозорец изберете New Window. 
ВМЪКВАНЕ НА ВАША КАРТИНКА 
Insert-> Picture-> From File-> Изберете желаната картинка, като стигнете до  
нея. По-бърз начин за вмъкване на ваша картинка е като изберете тази 

икона . 
ВМЪКВАНЕ НА КАРТИНКА ОТ CLIP ART 
Insert-> Picture-> Clip Art 

Или изберете тази икона  
* Имайте на предвид че трябва да са инсталирани всички компоненти на FrontPage, иначе командата 
Clip Art няма да действа. 
ВМЪКВАНЕ НА ХОРИЗОНТАЛНА ЛИНИЯ 
Insert-> Horizontal Line 
ВМЪКВАНЕ НА ДАТА И ВРЕМЕ 
Insert-> Date and Time-> Изберете желания формат-> OK 
ВМЪКВАНЕ НА HYPERLINK 
Insert-> Hyperlink-> В полето Text to display въведете името на Hyperlink-> Current  Folder-> Look in-> 
изберете файла към който ще сочи Hyperlink.  
Ако искате Hyperlink-а да се отваря в нова страница изберете Target Frame. 

По-бърз начин за вмъкване на Hyperlink е като изберете тази икона  или  
натиснете  Ctrl+K 
ВМЪКВАНЕ НА СНИМКОВА ГАЛЕРИЯ 
Insert-> Web Component-> Photo Gallery-> Изберете желания модел галерия-> Finish->  Pictures-> Add-> 
Pictures from Files-> изберете желаните картинки,  
които ще участват в снимковата галерия-> Layout-> Изберете желания модел-> OK 
* Може да попълните полетата: Caption(заглавие) и Description(описание). 
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* Ако искате да преправите настройките на снимковата галерия направете: 
десния бутон на мишката(върху галерията)-> Photo Gallery Properties 
ВМЪКВАНЕ НА СИМВОЛИ 
Insert-> Symbol-> изберете символ-> Insert 
ВМЪКВАНЕ НА ТЕКСТОВО ПОЛЕ 

Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ) и с курсора очертайте големината на текстовото 
поле. 
ВМЪКВАНЕ НА ГОТОВИ ОБРАЗИ 
Изберете тази икона  (ако не можете да я намерите се уверете че сте избрали следната икона 

), ще се появи следното меню: 
Lines (линии) 
Basic Shapes (основни образи) 
Block Arrows (стрелки) 
Flowchart (схеми) 
Stars and Banners (звезди и плакати) 
Callouts (пояснителни образи) 
More AutoShapes (други образи) 
 
* Ето няколко готови образи, за да може да добиете представа  

  
ВМЪКВАНЕ НА ЛИНИЯ 
Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ), вече може да начертаете желания размер на  
линия. 
ВМЪКВАНЕ НА СТРЕЛКА 
Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ), вече може да начертаете желания размер на  
стрелка.  
ВМЪКВАНЕ НА ПРАВОЪГЪЛНИК 
Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ), вече може да начертаете желания размер на  
правоъгълник.  
ВМЪКВАНЕ НА ЕЛИПС 
Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ), вече може да начертаете желания размер на  
елипса. 
ВМЪКВАНЕ НА АРТИСТИЧЕН ТЕКСТ 

Изберете тази икона  (ако не можете да я намерите се уверете че сте  

избрали следната икона ), изберете желания модел артистичен текст,  
натиснете OK. Въведете желания текст, може да смените шрифта, големината, получер, курсив. 
Натиснете OK. Желаният текст се появява в артистична 
форма. 
СМЯНА НА ЦВЕТА НА ДАДЕН ТЕКСТ 
Маркирайте желания текст(задържате левия бутон на мишката и маркирате) 

и изберете тази икона  .Сега задайте желания цвят в който ще бъдат  
буквите. 
ФОН НА ТЕКСТА 
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Маркирайте желания текст(задържате левия бутон на мишката и маркирате) и 

изберете тази икона . Сега задайте желания цвят в който ще бъде фона на 
текста. 
СМЯНА НА КОНТРАСТА НА ДАДЕНО ИЗОБРАЖЕНИЕ 
Селектирайте дадено изображение(с левия бутон на мишката, кликвате  
веднъж върху изображението) и изберете една от следните икони: 

- More Contrast (по-голям контраст) 

- Less Contrast (по-малък контраст)   
СМЯНА НА ЯРКОСТТА НА ДАДЕНО ИЗОБРАЖЕНИЕ 
Селектирайте дадено изображение(с левия бутон на мишката, кликвате  
веднъж върху изображението) и изберете една от следните икони: 

- More Brightness (по-голяма яркост) 

- Less Brightness (по-малка яркост) 
ЗАВЪРТАНЕ НА ДАДЕНО ИЗОБРАЖЕНИЕ 
Селектирайте дадено изображение(с левия бутон на мишката, кликвате  
веднъж върху изображението) и изберете една от следните икони: 

- Rotate Left (завъртане наляво)   

- Rotate Right (завъртане надясно)  
ПРЕГЛЕД В BROWSER 
За да видите вашето творение (станица или сайт) как ще изглежда в INTERNET трябва да го видите в 
Browser (Internet Explorer, Netscape, Opera или друг), 

за целта изберете следната икона . 
ВМЪКВАНЕ НА МУЗИКА 
В някои сайтове има музика(като фон), защо и във вашия да няма? За целта  
направете: 
File-> Properties-> Появява се прозореца Page Properties-> General->  
Background sound->  Location-> Browse-> изберете желаната музика (звук) -> Open 
* Имайте на предвид че може да вмъквате музики (звуци) с разширение Wave,Midi, Real  Audio, AIFF, AU 
Sound. Както виждате няма MP3, защото една 
песен в такъв формат от 4MB.(примерно), трудно би се заредила със слаба 
връзка. 
АЛТЕРНАТИВЕН ТЕКСТ НА HYPERLINK 
Insert-> Hyperlink-> Screen Tip-> Въведете желания алтернативен текст-> OK-> OK. 
* Не забравяйте да въведете и името на Hyperlink в полето: Text to display. 
* Сега след като направихте тази задача изпробвайте ефекта. Посочете с  
курсора направения Hyperlink, ще се появи вашият алтернативен текст. 
АЛТЕРНАТИВЕН ТЕКСТ НА КАРТИНКА 
Format-> Properties-> Появява се прозореца Picture Properties-> General-> Alternative  representations-> 
Text-> Въведете желания алтернативен текст-> 
OK 
* По лесен начин за достигане до Picture Properties е като кликнете с левия 
бутон (бързо) на мишката върху желаната картинка. 
* Сега след като направихте тази задача изпробвайте ефекта. Посочете с  
курсора върху картинката и ще се появи вашият алтернативен текст. 
ПУБЛИКУВАНЕ НА САЙТ ОТ FRONTPAGE 
File-> Publish Web-> Появява се диалоговия прозорец Publish Destination-> В 
текстовото поле Enter Publish Destination въведете пълният URL там където  
искате да публикувате  вашия сайт-> OK-> FrontPage ще се свърже към  
Интернет-> Publish Web-> Publish. 
* Това не е най-добрия начин за публикуване на вашия Web сайт или 
страница. 
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* Най-добре е да използвате специални програми за публикуване на сайтове. 
Като например Cute FTP, FTP Commander или друга програма. 
 

Въведение 
 Microsoft FrontPage e  приложение, което може да използвате за разработването на Web сайтове. Тази 
усъвършенствана програма осигурява всичко необходимо за създаването на всякакви Web сайтове, от 
обикновени Web-базирани автобиографии  до сложни магазини за продажба на Web. 
 Въпреки сложността си FrontPage е лесен за използване. Като част от пакета приложения Microsoft 
Office той работи по същият начин, по който работят останалите MS Office приложения. 
С FrontPage можете лесно да създавате добре изглеждащи и интересни сайтове със сложни елементи, 
без дори да пишете един ред програмен код. Но ако имате известен опит в програмирането на Html 
 или искате да се чувствате по-сигурни, FrontPage ви дава достъп до кода, който създава "зад кулисите". 
Можете да разглеждате и редактирате Html кода по всяко време, но най-удобното нещо е, че не се 
налага да правите това. 

Общ поглед върху FrontPage 
 Командите на FrontPage са достъпни от 10 отделни менюта. Те се преместват в горната част на всяко 
меню и по този начин се улеснява достъпът до тях. Командите на неизползваните менюта са скрити, но 
лесно можете да стигнете до тях, като щракнете върху двойните стрелки във формата на обърнато "V" 
от долната част на менюто. Командите на менютата, след който има многоточие (...), отварят диалогови 
прозорци за въвеждане на информация, необходима за тяхното изпълнение. 
Повечето от командите на менютата са представени графично чрез 12 ленти с инструменти (toolbars), 
всичките от които могат да бъдат настройвани според потребителските предпочитания. Графичните 
икони на бутоните в лентите с инструменти съответстват  на графичните икони, намиращи се до 
съответните команди от менютата. За всеки от бутоните има подсказващ текст (Screen Tip), който ви 
показва името на командата. 
Опциите на менютата и лентите с инструменти не могат да бъдат избирани, когато съответната опция 
не може да бъде приложена към средата, в която работите или към селектираният обект. Командите, 
които не могат да се избират са негативни и се показват в сиво.  
  

Първи стъпки 
 1. Стартирайте FrontPage.  
В лявата страна на лентата за задачи най-отдолу на екрана натиснете бутона Start.След това в менюто 
Start посочете Programs и изберете  Microsoft FrontPage. 
Когато FrontPage се отвори за първи път, в работният лист ще видите нова страница с име 
new_page_1.html .В този работен лист ще бъдат визуализирани всичките действия извършени от вас. 
Ето как изглежда екрана на FrontPage: 
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Когато стартирате FrontPage без да имате отворен сайт, се отваря панелът за задачи New Page or Web. 
Ако не искате този панел за задачи да се показва по подразбиране, премахнее отметката на полето 
Show at startup в неговата долна част.  
2. Щракнете с десния бутон на мишката върху областта с менюта и ленти с инструменти в горната част 
на екрана, за да отворите контекстното меню за лентата с инструменти както е показано по-долу.  

 
  
Чрез това меню вие може да отворите някое от изброените ленти с инструменти или пък да създадете 
ново по ваше желание чрез customize... 
Отметките показват, че в момента са отворени лентите с инструменти Standard и Formatting. FrontPage 
автоматично отваря тези две ленти с инструменти, защото те съдържат бутони за най-често 
използваните команди за страниците и файловете. 
Ето как изглежда лентата с инструменти Standard: 
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А ето как изглежда и лентата с инструменти Formatting: 

 
Посочете всеки от бутоните в лентите с инструменти  Standard и Formatting, за да видите имената на 
командите им. 
Всеки активен бутон се маркира, когато показалецът на мишката минава над него. 
  
3. В долният ляв ъгъл на FrontPage ще намерите следните бутони: normal, html, preview. 

 
Благодарение на бутона "html" вие можете да осъществявате достъп до програмният код на вашият 
сайт, а чрез бутонът "preview" вие може да видите как ще изглежда вашата страница. Съответно чрез 
"normal" се връщате обратно в работният лист на FrontPage. 
 

Менюта 
МЕНЮ FILE  
 

1. New(ново)-При избора на това меню вие създавате нов 
документ. Имате създадени основни видове проекти : 
1.1 Page or Web-Създаване на нов стандартен документ от шаблон 
или с помощта на помощник (Wizard) 
1.2 Folder(папка)-Създаване на папка във вашия документ 
1.3 Document Library(библиотека)-Създаване на Библиотека от 
шаблон или с помощна на помощник (Wizard) 
1.4 List(лист)-Създаване на лист от документи от шаблон или с 
помощта на помощник (Wizard) 
1.5 Survey(план)-Създаване на общ план на проекта 
1.6 Task(задача)-Създаване на задача за вашия проект 
2. Open(Отвори)-Отваряте нов документ записан върху вашия 
компютър 
3. Close(затвори)-Затваряте активния документ 
4. Open web (отвори проект)-Отваряне на вече публикувана или 
записана страница 
5. Close web (затвори проект)-Затваряне на страница 
6. Save (Запази)-Запазване на документ   
7. Save as (Запази като)-Запазване на документа под произволно 
име. Наложително е да извършите Save as преди Save 
8. Save all (Запази всички)-Запази всички отворени документи 
9. Search (Намери)- Търси документи или проекти които имат 
въведеният критерий 
10. Publish web (публикувай проект)- Публикувай проекта си. 
Зависи от вашия сървър (поддръжка) на HTTP и FTP) 
11. Import (вмъкни)- Вмъкване на готови проекти с помощта на 
помощник 
11.1 One Page Web- Проект само от една страница 
11.2 Corporate Presence Wizard- Създаване на страница за 
промоции на продукти 
11.3 Customers Support Web - Сайт с възможност за поддръжка 
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11.4 Database Interface Wizard-Сайт подобен на FTP ( file transfer 
protocol ) 
11.5 Discussion Web Wizard- Сайт за дискусии 
11.6 Empty Web- Празен сайт 
11.7 Import Web Wizard -Вмъкване на проект 
11.8 Personal Web- Личен сайт 
11.9 Project Web- Проектен сайт 
11.10 SharePoint- based Team Web Site- Въведение на FrontPage за 
сайт който се използва от много потребители 
12. Export (изнеси)- Копиране на избран фрагмент от документа и 
преместването му на друго място 
13. Review in browser (прегледай в браузер)- Преглед на проекта в 
браузер (Opera ,IE , Gozila и др.) 
14. Page Setup (настройки на страница)-Промяна на настройките 
на страницата (ръководно заглавие, пространства между върха и 
дъното и др. настройки) 
15. Print Review (предпечатен преглед)- Преглед на страницата 
преди да започне принтирането 
16. Print (принтирай)- Принтиране на документа, настройки на 
принтера, избор на страница и др. 
17. Send (изпрати)- Изпрати проекта като прикачен файл към e-
mail  
18. Properties (настройки)- Настройки на FrontPage 
19. Recent Files (скорошни документи)-Отваряне на  скорошно 
създаден документ 
20. Recent Webs (скорошни проекти)- Отваряне на скорошно 
създаден проект 
21. Exit (изход)-изход от FrontPage 

МЕНЮ EDIT  

1. Undo- Командата отменя последната операция която е 
направил потребителя 
2. Redo- Командата извършва следващата команда. Забележка: 
трябва да сте използвали Undo 
3. Cut- Изрязвате текст или файл от вашия проект. 
4. Copy- Копира текст или файл от вашия проект. 
5. Office Clipboard- Навигация на Clipboard-a. Има възможност за 
събиране на 24 елемента 
6. Paste- Вмъкване на текст или файл от Clipboard. 
7. Paste Special- Настройки на изрязания или копиран елемент 
8. Delete- Изтриване на маркиран елемент. 
9. Select All- Маркиране на всичко 
10. Find- Намиране на елемент във вашия проект. 
11. Replace- Замества елемент във вашия проект. 
12. Check Out- Не позволява на други потребители да променят 
даден файл. 
13. Check In- Позволява на други потребители да променят 
даден файл. 
14. Undo check out-Отменя командата Check out. 
15. Tasks- Задачи по вашия проект. 
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МЕНЮ VIEW  

1. Page- Изглед на нормалната страница. 
2. Folder- Изглед на папките във вашия проект 
3. Reports- Доклади за определени изисквания 
4. Navigation- Навигация на елементите във вашия проект. 
5. Hyperlinks- Изглед на хипервръзките. 
6. Tasks- Преглед на задачите 
7. View bar- Включване на десния View bar. 
8. Folder list- Лист със папките. 
9. Navigation pane- План на навигацията. 
10. Reveal tags- Показване на скритите тагове. 
11. Task pane- План на задачите. 
12. Toolbars- Управление на бутоните. 
13. Refresh- Рестартиране на проекта. 

 
 
МЕНЮ INSERT  

1. Break- Вмъкване интервал от няколко възможности. 
2. Horizontal line-Вмъкване на хоризонтална линия. 
3. Inline Frame-Вмъкване на подстраница от изходящ файл или нова 
страница. 
4. Date and Time-Вмъкване дата и час. 
5. Symbol-Вмъкване на символ. 
6. Comment-Вмъкване на коментар. 
7. Navigation-Вмъкване елемент от навигацията 
8. Page Banner-Вмъкване на банер. 
9. Web Component-Вмъкване на Интернет компонент от категориите 
вдясно. 
10. Database-Вмъкване на база от данни. 
11. Form-Меню за вмъкване на специални форми във вашия проект. 
11.1 Form- Вмъкване на контакт. 
11.2 List Form- Вмъкване на интерактивен лист или библиотека. 
11.3 List Field-Вмъкване на интерактивен лист или библиотека. 
11.4 Textbox-Вмъкване на кутия за текст. 
11.5 Text area-Вмъкване на място за текст. 
11.6 File Upload-Вмъкване на поле за качване на файлове. 
11.7 Checkbox-Вмъкване на място за маркиране. 
11.8 Option Button-Вмъкване на бутон за маркиране. 
11.9 Group Box-Вмъкване на многофункционална кутия. 
11.10 Drop-down Box-Вмъкване на падащо меню. 
11.11 Push Button-Вмъкване на 3-д бутон. 
11.12 Advanced Button-Вмъкване на допълнителен бутон. 
11.13 Picture-Вмъкване на картинка. 
11.14 Label-Вмъкване на настройка за текст. 
11.15 Form Properties- Настройки на формите 
12. Pictures-Вмъкване на картинки или други мултимедийни 
файлове. 
12.1 Clip Art-Вмъкване на картинка от Клип арта. 
12.2 From file-Вмъкване на файл от хард диска. 
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12.3 From Scanner or Camera-Вмъкване на файл от скенер или 
камера. 
12.4 New Photo Gallery- Вмъкване на галерия. 
12.5 New Drawing-Вмъкване на поле за рисуване. 
12.6 AutoShapes-Вмъкване на автоматични картинки. 
12.7 Word Art-Вмъкване на артистичен текст. 
12.8 Video-Вмъкване на видео. 
13. File-Вмъкване на файл. 
14. Bookmark-Вмъкване на място, което може да се използва като 
хипервръзка. 
15. Hyperlink-Вмъкване на хипервръзка. 

 
  МЕНЮ FORMAT  

1. Font- Настройка на текста. 
2. Paragraph- Настройки на параграфите. 
3. Bullets and Numbering- Управление на точки и 
подточки. 
4. Borders and Shading- Настройки на рамките. 
5. Position- Управление на позицията на даден 
елемент. 
6. Dynamic DHTML effect- Динамични ефекти 
7. Theme- Използване на теми. 
8. Style- Използване на стилове. 
9. Style Sheet Links- стил на страницата (.css)  
10. Shared Borders- Споделена рамка или цял 
документ. 
11. Page Transition- Използване на ефекти. 
12. Background- Управление на фона. 
13. Remove Formatting- Премахва досегашните 
команди. 
14. Properties- Настройки 
 

 

 
МЕНЮ TOOLS  

1. Spelling - (правопис) за да проверите за грешки във 
вашия текст сравнявате маркираната дума с дума от 
речника. 
2. Thesaurus- (източник) предлага набор от синоними, 
които могат да се използват в текстови файлове 
3. Set Language- (поставяне на език) 
4. Speech- (говор) 
5. Auto Thumbnail- (автоматични миниатюри) 
6. Recalculate Hyperlinks- (връщане на линкове) 
7. Server- (обслужване) 
8. Tools on the Web...- ( инструменти за мрежата) 
9. Macro- ( макрос) 
9.1 Macros...- (макроси) 
9.2 Visual Basic Editor - (редактор за Visual Basic) 
9.3 Microsoft Script Editor - (Microsoft редактор на 
скриптове) 
10. Add-Ins - (прибавяне на приложения) 
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11. Customize - (настройки) 
12. Web Settings - (мрежови настройки) 
13. Options - (опции) 
14. Page options - (опции на страницата) 

 
  МЕНЮ TABLE  

1. Draw Table - (рисувам, чертая таблици) 
2. Insert - (вмъквам) 
2.1 Table - (таблица) 
2.2 Rows or Columns - (поредица от редове или колони) 
2.3 Cell - (клетка) 
2.4 Caption - (обяснение) 
3. Delete Cells - (изтриване на клетки) 
4. Select - (избирам) 
4.1 Table - (таблица) 
4.2 Column - (колона) 
4.3 Row - (ред) 
4.4 Cell - (клетка) 
5. Merge Cells - (сливам клетки) 
6. Split Cells - (разделяне на клетки) 
7. Split Table - (разделяне на таблици) 
8. Table AutoFormat - (таблици за автоматичен формат) 
9. Distribute  Rows Evenly - (последователно разпределение 
на редовете) 
10. Distribute Columns Evenly - (последователно 
разпределение на колоните) 
11. AutoFit  to Contents - (автоматично приемане) 
12. Convert - (преработка) 
12.1 Text to Table - (от текст в таблица) 
12.2 Table to Text - (от таблица в текст) 
13. Fill - (попълване на...) 
14. Table Properties - (таблични настройки) 
14.1 Table - (таблица) 
14.2 Cell - (клетка) 
14.3 Caption - (заглавие) 

 

 
МЕНЮ FRAMES  

1. split frame - (разделяне на рамки) 
2. delete frame - (изтриване на рамки) 
3. open page in new window - (отваряне на 
страница в нов прозорец) 
4. save page - (записване на страница) 
5. save page as... - (запазване на страница под 
адрес) 
6. frame properties - (аксесоари за рамката)  
   
МЕНЮ WINDOW  
1. New Window - Нов прозорец 
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МЕНЮ HELP  

1.Microsoft FrontPage Help -  FrontPage помощ  
2. Hide the Office Assistant - скрии офис асистента 
3. What's This? - Какво е това? 
4. Office on the Web - Офис в Интернет  
5. Activate Product - Активиране на продукта 
6. Detect and Repair - Засечи и поправи 
7. About Microsoft FrontPage - За нас от Microsoft 
FrontPage 

 
 

Текст 
FrontPage ви позволява да въвеждате нов текст във всяка Web страница директно от клавиатурата. 
Програмата ви позволява да разполагате текста на страницата, да го подравнявате, оцветявате, да 
редактирате текста и да вмъквате нов по всяко време, да задавате големината на шрифта и самия 
шрифт. 
За целта може да използвате лентата с инструменти Formatting. С нея най-бързо и лесно може да 
зададете желаният от вас формат на текста. 
  
Форматиране на текст чрез лентата с инструменти Formatting 
  
1. Нека първо да въведем текст в началото на работния  лист. След това маркираме въведеният от нас 
текст. И сменяме шрифта му от Times New Roman (това е шрифта на текста по подразбиране) на Arial 
Black както е показано на картинката: 

 
резултат: Текст 
2. След това ще променим големината на текста чрез полето "font size" от 3 на 4, както е показано на 
картинката: 

 
резултат: Текст 
Друг начин за оголемяване или намаляване на текста е чрез полето style: 
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3. След като сменихме шрифта и големината на текста е време и да го наклоним и позиционираме по 
средата на страницата. За целта използвайте картинката: 

 
(маркираме бутоните Underline, за да подчертаем текста и бутона Center, за да го центрираме) 
резултат:                                   Текст 
Благодарение на останалите бутони показани на картинката вие ще може да удебелявате, накланяте 
или позиционирате текста съответно в ляво (под подразбиране) в центъра или в дясно. 
4. Сега нека оцветим полученият до тук  текст в червено и го поставим на син фон. За целта използваме 
бутоните показани на картинката: 

 
Чрез първият бутон избираме фона на текста, а чрез втория цветът му. 
резултат: Текст 
  
Форматиране на текст чрез диалоговия прозорец "font" 
 Има и още една възможност, за форматиране на даден текст. Това става чрез диалоговия прозорец 
"font". 
1.Може да извикате диалоговия прозорец "font" по два начина: 
a) маркирате желаният от вас текст, шраквате с десен бутон и избирате полето "font". 
b) избирате менюто Format и след това шраквате върху полето "font" 
И в двата случая ви се появява следният диалогов прозорец: 

 
Тук може да правите същите преобразувания на текста който направихме и по горе. 
от секция Font: можете да избирате шрифта на вашия текст. 
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от секция Font Style: може да избирате какъв да е стилът на избрания от вас текст ( да ли да е нормален, 
наклонен, удeбелен или пък и удебелен и наклонен) 
от секцуя Size: може да нагласите големината на текста. 
от секция Color: може да избирате цвят за текста си. 
от секция Effects: може да сложите ефект на текста си (да го подчертаете, задрскате, повдигнете, да 
направите всичките му букви големи и т.н.) 
в секция Preview: може да видите как ще изглежда вашият текст след форматирането. 
  

Вмъкване на символи 
FrontPage е програма която позволява вмъкването на символи във вашия сайт, които не може да 
вмъкнете чрез клавиатурата. 
1. За да вмъкнете търсеният от вас символ от менюто Insert  изберте Symbol, за да отворите диалоговия 
прозорец "Symbol". 

 
2.От падащият списък font изберете желаната от вас категория и маркитайте символът, който бихте 
искали да вмъкнете. 
3.След това натиснете бутона insert, а след това и 
бутона cancel. 
  

Позициониране на текст 
  
1. За да позиционираме добре един текст е нужно 
да се запознаем с диалоговия прозорец Paragraph. 
За целта изберете менюто Format- Paragraph. 
В диалоговия прозорец "Paragraph" направете 
следното: 
2.От падащия списък Alignment изберете Center. 
3.В полетата Before text и After text на областта 
Indentation задайте стойност 15. 
4.В полетата Before text и After text на областта 
Spacing задайте стойност 0. 
Диалоговия прозорец изглежда по следният начин: 
 
а ето го и резултата: 
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1. За да позиционираме добре един текст е нужно да се запознаем с диалоговия прозорец Paragraph. 
За целта изберете менюто Format- Paragraph. 
В диалоговия прозорец Paragraph направете следното: 
2.От падащия списък Alignment изберете Center. 
3.В полетата Before text и After text на областта Indentation задайте стойност 15. 
4.В полетата Before text и After text на областта Spacing задайте стойност 0. 
Диалоговия прозорец изглежда по следният начин: 

 
Създаване на списъци 
Списъците се използват за разделяне на отделни елементи информация, които се забелязват трудно, 
ако се намират в текстов параграф. Ако елементите не трябва да са в определен ред те обикновенно се 
поставят в списъци с точки (bulleted lists). Ако пък елементите трябва да се подредят в определен ред 
те се поставят в номерирани списъци. 
За създаване на номерирани списъци и списъци с точки във  FrontPage се използват същите техники, 
както и в Microsoft Word. 
 1.Стартирайте FrontPage, ако не е отворен. 
2.Въведете следният текст както е показано тук: 

Иван 
Георги 
Захари 

4.Сега ще направим един подреден списък чрез буона "numbering"  в лентата с инструменти Formatting. 

 
Резултат: 

1. Иван  
2. Георги  
3. Захари  

5.Сега ще направим и един неподреден списък чрез буона "bullets"  в лентата с инструменти 
Formatting. 

 
Резултат: 

 Иван  
 Георги  
 Захари  

6.Нека сега променим подреденият списък да е с римски цифри. За целта маркираме подреденият 
списък и избираме менюто Format-Bullets and Numbering.  
След като се отвори диалоговият прозорец Bullets and Numbering направете следните преобразувания, 

както са показани на картинката: 
 
(избираме страница "Numbers" И маркираме списъка с 
римски цифри, след което натискаме "ОК") 
Резултат: 
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I. Иван  
II. Георги  

III. Захари  

7.Следва да променим и неподредения списък , като ще заменим точките с квадратчета. За целта 
маркираме неподредения списък и избираме менюто Format-Bullets and Numbering.  
След като се отвори диалоговия прозорец Bullets and Numbering направете следните преобразувания, 
както са показани на картинката: 

 
(избираме страница "Plan Bullets" и макираме списъка с квадратчета, след което натискаме "ОК") 
Резултат: 

 Иван  
 Георги  
 Захари  

8.Сега ще направиме още един неподреден списък, но този път ще използваме графичен обект. 
За целта маркираме неподредения списък и избираме менюто Format-Bullets and Numbering.  
След като се отвори диалоговия прозорец Bullets and Numbering направете следните преобразувания, 
както са показани на картинката: 
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(избираме сраница "Picture Bullets" маркираме полето "Specify picture:" и ибираме желаният от нас 
графичен обект чрез бутона "Browse...") 
Резултат: 

 Иван 

 Георги 

 Захари 
  

 

Хоризонтални линии 
Чрез FrontPage освен картинки и други уеб компоненти вие може да вмъквате и хоризонтални линии. 
Хоризонталните линии спомагат за отделянето на части от страницата, а може да се използват и за 
подчертаване на важен текст както и за други неща. 
  
Вмъкването на хоризонтална линия в FrontPage става много лесно и бързи.  
1.За целта просто трябва да изберете менюто Insert и изберете Horizontal Line. След като се вмъкне, 
хоризонталната линия отива на мястото на което сме позиционирали курсора. 
резултат: 

 
Друга възможност която FrontPage позволява на потребителите  е да сменят цвета, големината и 
разположението на хоризонталната линия. 
2. Щракнете двукратно с ляв бутон върху вмъкнатата линия. Отваря ви се следният диалогов прозорез: 

 
Чрез този прозорец вие може да променяте: 
- Големината на линията от полето "Size". Това включва дължината 
(Width) и широчината (Height). 
- Разположението на линията от полето "Alignment". Това включва 
позициониране в ляво (left), в средата (center) и в дясно (Right). 
- Цветът на линията от полето "Color" 
  3. След като разбрахме по какъв начин може да форматираме една 
хоризонтална линия, нека да направиме линия с размери 300x10 
pixels, да я позиционираме в ляво и да я оцветим в син цвят. 
 
 
 
 

Хиперлинкове 
 FrontPage e програма, която ви позволява да правите препратки към други страници, към части от 
същата страница, към файлове, картинки, електронна поща. Тези препратки се наричат ХИПЕРЛИНКОВЕ 
(или хипервръзки). Без хиперлинковете един web сайт не би имал никакъв смисъл. 
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Препратки към страници 
 1. Нека създадем една страница с име links.htm 
2. И нека да сложим жълт фон на страницата.  
За целта щракнете с десен бутон на мишката някъде в страницата и от падащото меню изберете “Page 
Properties…”.  
След това изберете страница background и в падащото меню с цветове “background” изберете жълт 
цвят, както е показано на картинката: 

 
Както забелязвате в горепосоченият диалогов прозорец освен фона (backgrоund) на страницата, може 
да посочите и цвета на текста (text), както и цвета на връзките (hyperlink), цветът на посетените връзки 
(visited hyperlink) и цветът на активните връзки (active hyperlink). 
За сега ще оставиме цветът на връзките да бъде под подразбиране. 
3.Следваща стъпка е да направиме и самите линкове. 
За целта първо ще напишем имената на 3 сайта: 

dir.bg 
hit.bg 
search.bg 

След като написахме имената сега ще зададем и връзките към самите сайтове. За да стане това трябва 
първо да маркираме желаният текст и да щракнем с десен бутон на мишката върху маркираният текст. 
От падащото меню избереме hyperlink и след като се отвори диалоговият прозорец insert hyperlink 
правим следните настройки: 
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В полето Address: Пишем пълният адрес на сайта и натискаме бутона "ОК". 
Резултат: 

dir.bg 
hit.bg 
search.bg 

Ако искаме обаче да задаем линк към страница намираща се на компютъра ни, ще трябва да 
използваме полето Look in: чрез което да открием желаната страница.Същата процедура се прилага и 
когато искаме да направим линк към картинка или някакъв друг файл. 
  
Препратка към електронна поща 
  
4.Нека сега добавим към страницата links.html, линк към електронна поща. 
За целта отново избираме диалоговият прозорец insert hyperlink, но този път от полето Link to: 
избираме опцията E-mail Address. 

 
в полето E-mail address: пишем съответно адреса на електронната пощата, а в полето Text to display: 
текста, който искаме да ни се покаже, като връзка към пощатата. 
резултат: 

dir.bg 
hit.bg 
search.bg 
mailto:front.@abv.bg 

http://www.dir.bg/
http://www.hit.bg/
http://www.search.bg/
http://www.dir.bg/
http://www.hit.bg/
http://www.search.bg/
mailto:front.@abv.bg
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Препратки към части от същата страница 
  
Освен препратки към други страници и препратки към електронна поща, FrontPage позволява и 
препратки към наименована част от документа. 
5.За да направиме такъв вид връзка първо ще трябва да именоваме част от нашата страница. За целта в 
началото на документа ще въведем текст: 
  

Links 
  
dir.bg 
hit.bg 
search.bg 
mailto:front.@abv.bg 
  
  

Сега ще наименуваме текста "links" като го маркираме и изберем менюто Insert-Bookmark 

 
След като се появи диалоговият прозорец "Bookmark", натискаме бутона "ОК" и текста вче е 
наименуван. 
Сега остава да зададем линк към тази наименована част. 
Отново въвеждаме текст в документа, но този път в края му: 

Links 
  
dir.bg 
hit.bg 
search.bg 
mailto:front.@abv.bg 
  
back at top 

След като маркиркираме въведеният текст щракнем с десен бутон на мишката и от падащото меню 
избереме hyperlink и след като се отвори диалоговият прозорец insert hyperlink натискаме бутона 
bookmark... и от новоотворилият се диалогов прозорец  "Select Place in Document" селектираме 
наименованата част. След което натискаме бутона "ОК". 

http://www.dir.bg/
http://www.hit.bg/
http://www.search.bg/
mailto:front.@abv.bg
http://www.dir.bg/
http://www.hit.bg/
http://www.search.bg/
mailto:front.@abv.bg
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Резултат: 

Links 
  
dir.bg 
hit.bg 
search.bg 
mailto:front.@abv.bg 
  
back at top 

 

КАРТИНКИ 
 Една от най-силните характеристики на FrontPage е възможността да разполагате картинки върху 
страницата си. Чрез тази опция вие може да вмъквате графични обекти от вашия компютър в сайта си. 
Това става oт менюто insert - pictures - from file... 
След като се отвори диалоговият прозорец "Picture" от него избирате желаната картинка и я вмъквате 
във вашия сайт.   

 
Картинка може да вмъкнете и чрез лентата с инструменти Standard, чрез бутона insert picture from file 

 
Резултат: 

http://www.dir.bg/
http://www.hit.bg/
http://www.search.bg/
mailto:front.@abv.bg
http://lbulgaria.com/htmlpage/front%20page/hyperlinks.htm#Links#Links
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Така на екрана си вече имате картинка на делфин. В FrontPage и в HTML най-често се използват 
графичните формати GIF(.gif) и JPEG(.jpg). Предимството на първия е, че може да съдържа анимация и 
прозрачен фон, но се ограничава само до 256 цвята. При втория формат няма ограничение за цветовете 
и картинките са с по-високо качество, но пък нямате 
прозрачен фон, нито анимация. Картинката на 
делфина е от типа JPEG.  
Когато слагате картинка на web страницата си трябва 
да знаете от колко точки е съставена хоризонтално и 
вертикално. Например картинката на делфина е от 
300 точки хоризонтално и 375 вертикално(кликнете с 
десния бутон на мишката върху картинката и от 
менюто изберете Picture Properties за да видите от 
колко точки е картинката). Вие разбира се можете да 
свиете или разширите изображението. Това става с 
атрибутите WIDTH и HEIGHT в диалоговия прозорец 
Picture Properties .  
Нека направим същата картинка на делфин да се 
показва като 150x187 пиксела. 
За целта използвайте картинката: 
 
За да променим големината на снимките първо 

трябва да сложим отметка на бутона Specify size, a след това да махнем отметката 
на бутона Keep aspect ratio. После просто променяме Width на 150 и Height на 
187. 
ето го и резултата: 
 
Картинките често служат и като хиперлинкове към други страници (виж 
ХИПЕРЛИНКОВЕ). За да добавите хиперлинк към картинка, трябва да маркираме 
желаната картинка и с десен бутон на мишката от падащото меню да изберем 
Hyperlink... От там нататък процедурата е същата както е и при връзки към 
страници. 

След като се отвори диалоговият прозорец Insert Pictures, в полето address пишем адреса, който искаме 
да се отваря при кликване на картинката, даваме "ОК" и вече имаме картинка която служи като 
хипервръзка към друга страница. 
Резултат: 

  
Когато изображението е комбинирано с хиперлинк, то се показва оградено със синя рамка. За да 

http://lbulgaria.com/htmlpage/front%20page/hyperlinks.htm
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махнете досадната синя рамка, използвайте отново диалоговият прозорец Picture Properties , като 
зададете стойността на полето Border thickness да е 0. При промяна на стойността на Border thickness се 
променя и дебелината на рамката. Вижте картинката с кучето, само че с рамка с дебелина 10 пиксела  
 

Таблици 
 Таблицата се състои от вертикално разположени колони и хоризонтално разположени редове . Тя 
може да има общо заглавие, което се извежда като отделен параграф над основната и част или в най-
горния и ред. Таблицата обикновено има заглавен ред, който съдържа заглавията на всяка колона и 
заглавна колона, съдържаща заглавията на всеки ред. 
  
Създаване на таблици 
 За да вмъкнете таблица в сайта си може да използвате следните 2 начина: 
чрез бутона Insert Table от лентата с инструменти standard 
или чрез менюто Table- Insert-  Table... 
  
1. Натиснете бутона Insert table от лентата с инструменти standard 

 
FrontPage извежда следната решетка от пет реда и четири колони: 

 
2. Посочете първата клетка (пресечната точка на първия ред с първата колона) и задръжте левия бутон 
на мишката натиснат. Издърпайте показалеца, докато маркирате област с три клетки ширина и пет 
клетки височина (когато влачите мишката към долния край, мрежата се разширява), и след това 
отпуснете бутона на мишката. 
FrontPage вмъква таблица с толкова редове и колони, колкото сте маркирали: 
Резултат: 

      

      

   

      

      

  
Друга възможност да получиме същият резултат е чрез менюто table. 
1. За целта избираме Table- Insert- Table... 
На екрана ви се извежда следният диалогов прозорец 
(Insert Table): 
 
2. За да вмъкнеме таблица като предишната с 5 реда и 3 
колони, в полетo Rows въвеждаме съответно 5, а в 
полето Columns- 3. 
  
Форматиране на таблици 
 Във  FrontPage също като в Word има няколко 
възможности за форматиране на таблици. Можете да 
избирате измежду много предварително форматирани 
стилове за таблици или да създавате собствен изглед на 
таблица. Можете дори да сливате две или повече 
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клетки в една, така че информацията да се 
разпростира на няколко колони или реда. 
 1. Направете нова таблица отново с 5 реда и 3 
колони. 
2. Селектирайте трите клетки на първия ред. 
3. Щракнете с десен бутон на мишката върху 
селекцията и от контекстното меню изберете Cell 
Properties, за да отворите следния диалогов 
прозорец: 
 
4. В диалоговия прозорец Cell Properties отбележете 
полето за отметка Header cell. 
5. В областта Background  изберете любимия си цвят 
и натиснете бутона "ОК", за да затворите диалоговия 
прозорец и да приложите промените. 
Ето го и резултата: 

      

      

   

      

      

Сега е ред да форматираме таблицата чрез 
предварително форматираните стилове. 
6. Щракнете някъде в таблицата. 
7. От менюто Table  изберете Table AutoFormat. 
8. В диалоговия прозорец Table AutoFormat 
превъртете опциите от списъка Formats, 
намиращ се от ляво, като избирате всеки от 
форматите. 
  
Когато селектирате даден формат, в прозореца 
Preview се визуализира примерната таблица, 
към която е приложен този формат, ето така: 
 
9. Селектирайте формата Subtle1. 
Ето го и резултата: 

      

      

   

      

      

  
Редактиране на структурата на таблица 
  
Ако нямате голям опит в работата с таблици, рядко ще създавате таблици, които впоследствие да не 
промените по един или друг начин. В повечето случаи ще трябва да добавяте или изтривате редове или 
колони и да премествате информацията, докато я поставите на правилното място. Почти сигурно е, че 
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ще ви се налага да променяте размера на редовете и колоните, които са твърде големи, твърде малки 
или неравномерно разпределени. Отстраняването на всички изброени проблеми свързани със 
структурата е лесно във FrontPage. 
Сега нека променим малко структурата на таблица от предишния пример. 
1. В първата колона селектирайте първите две клетки и от менюто Table изберете Marge Cells. 
FrontPage слива двете клетки в една. 
2. Същата процедура направете и за вторите две кледки в първата колона. 
Ето го и резултата: 

      

  
  

    

  

  
  

    

    

  
Нека направим ново упражнение. Този път ще вмъкнем един ред и една колона във вече съществуваща 
таблица. 
1. Направете отново една таблица със 5 реда и 3 колони. 
2. Щракнете в най-горния  ред на таблицата. 
3. В менюто Тable посочете insert и изберете  Rows or Columns, за да отворите следния диалогов 
прозорец: 

 
4. В полето Number of Rows задаваме стойност 1 и в областта Location селектираме опцията Above 
Selection. После натискаме "ОК". 
FrontPage вмъква нов ред в най- горната част на страницата. 
  
Процедурата за вмъкване на колона е абсолютно същата, само че вместо радио бутона за Редове 
(Rows) избираме бутона за Колони (Columns) и вмъкваме новата колона или в ляво от селектираната 
или в дясно. 

 
Формуляри 

Освен за показване на информация WEB страниците могат да служат и за събиране на информация от 
потребителя. Това става с така наречените формуляри. За съжаление FrontPage не ви позволява да 
управлявате информацията във формулярите, а само да ги разполагате на страницата си.  
Всички форми в Front Page се вмъкват посредством менюто Insert - Form. 
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1 Form- Вмъкване на контакт. 
2 List Form- Вмъкване на интерактивен лист или библиотека. 
3 List Field-Вмъкване на интерактивен лист или библиотека. 
4 Textbox-Вмъкване на кутия за текст. 
5 Text area-Вмъкване на място за текст. 
6 File Upload-Вмъкване на поле за качване на файлове. 
7 Checkbox-Вмъкване на място за маркиране. 
8 Option Button-Вмъкване на бутон за маркиране. 
9 Group Box-Вмъкване на многофункционална кутия. 
10 Drop-down Box-Вмъкване на падащо меню. 
11 Push Button-Вмъкване на 3-д бутон. 
12 Advanced Button-Вмъкване на допълнителен бутон. 
13 Picture-Вмъкване на картинка. 
14 Label-Вмъкване на настройка за текст. 
15 Form Properties- Настройки на формите 
 

 
Нека в това упражнение да разположим един формуляр за име, за парола, място за текст, анкета и 
падащо меню. 
  

Textbox 
  
1. За да въведем формуляр за въвеждане на име от менюто Insert- Form избираме бутона Textbox 
резултат: 

 
Submit Reset

 
Нека направим така, че в полето за въвеждне на име автоматично да се появява "enter your name"  
2. Щракаме двукратно върху формата за въвеждане с ляв бутон на мишката. След като се появи 
диалоговият прозорец "Text Box Properies", правим следните настройки: 
В полето Initial Value въвеждаме текста "Enter your name". 

 
резултат: 

 

enter your nam Submit Reset
 

4. За да вмъкнем форма за парола отново използваме бутона Textbox. 
5. След като влезем в диалоговият прозорец "Text Box Properies" в полето password field: маркираме 
бутона Yes както е показано на снимката: 
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ето го и резултата: 

 
Submit Reset

 
Също така FrontPage позволява да преименувате бутоните "submit" и "reset". 
6.Нека прейменуваме бутоните "submit" и "reset" съответно на "пусни" и "изчисти" 
За целта отново с двукратно щракане на левият бутон на мишката отвяряме следния диалогово 
прозорец: 

 
И в полето Value/label: пишем вместо "submit"- "пусни". 
Същата процедура правиме и за бутона "reset" като го променяме на "изчисти". 
ето го резултата: 

 
пусни изчисти

 
Text area 
  
1. За да въведем формуляр за въвеждане на текст  от менюто Insert- Form избираме бутона Text area 
резултат: 

 

Submit Reset
 

Така вече имате готова форма за въвеждане на свободен текст. 
Тук настройките са абсолютно същите както и при предходните форми, които направихме. Затова ако 
искате автоматично да ви се показва някакъв текст в тази форма отново при отваряне на прозореца 
"TextArea Box Properties" в полето "Initial Value" въвеждаме желаният текст. 
резултат: 
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въведи текст...

Submit Reset
 

Checkbox  & Option Button 
  
Нека направиме по една анкета с Check и Option бутоните. 
1. За да вмъкнем няколко на брой Option бутона в една страница трябва да изберем менюто Insert- 
Form, а след това бутона Option Button 
Така на страницата си вече имаме следната форма: 

 
Submit Reset

 
Ако повторим обаче това действие още три пъти (Insert- Form- Option Button) ще получим следният 
резултат: 

 
Submit Reset

 
Важно е обаче преди това да сте позиционирали курсора в полето на формата маркирано със 
пунктирна линия от точки. 
  
Нека сега дообработиме формата така, че да се получи една хубава анкета. 
2. За целта най- отгоре на формата въведете въпросът на анкетата, а в страни от всеки option button 
въведете и възможните отговори. 
резултат: 

 
Do you like our site? 
  

Yes 

No 

Maybe 

I don't know 
  

Submit Reset
 

При двукратно щракане върху някое от бутоните може да задавате, чрез даилоговият прозорец 
"OptionButton Properties" кои от бутоните ви да бъдат "селектирани" и кои не. Това става от полето 
Initial state: 

 
3. Да повторим тази процедура отново този път обаче от менюто Insert- Form ще изберем Checkbox. 
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Разликата между Checkbox  и Option Button е, че при  Checkbox  можете да изберете няколко 
възможности, докато при Option Button може да изберете само една. 
ето го и резултата: 

 
Submit Reset

 
Drop-Down Box 
  
Drop-Down е бутон, който предлага няколко възможности под формата на падащо меню. 
1. За да вмъкнете Drop-Down Box в страницата си трябва да изберете менюто Insert- Form, а след това и 
бутона Drop-Down Box. 
ето го резултата: 

 
Submit Reset

 
За да въведете възможнсти за селектиране щракнете два пъти с ляв бутон на мишката върху формата. 
След като се появи прозореца "Drop-Down Box Properties", 

 
натискаме бутона "add..." и почваме да въвеждаме възможностите за селектиране. 

 
В полето "Choice" пишем избрания текст и така повтряме действието взависимост от това колко 
възможности искаме да имаме. 
резултат: 

 

отговор А Submit Reset
 

 



 29 

Рамки 
  
Сигурно често сте виждали страници, които са разделени на отделни части. Такива части се наричат 
рамки (frames) или фреймове. Разделянето на рамки позволява да се показва различен документ във 
всяка рамка, както и хиперлинкове от една рамка да се показват в друга. Рамките, често се използват за 
отделянето на навигацията на сайтовете от самия сайт. 
В FrontPage фреймовете се създават посредством панела за задачи (New page or Web). 
1. Ако случайно сте изгасили панела за задачите вие можете лесно да го извикате от File- New- Page or 
Web... 
2. След като  New page or Web панела се появи в ляво на вашия FrontPage екран, от графата New from 
template изберете Page Templates... 

 
3. След като се отвори диалоговия прозорец "Page Templates" и след като изберете страница Frames 
Page работата ви с рамки може да започне. 

 
Щом вече сте в страницата Frames Page на диалоговия прозорец Page Template вие вече може да 
избиререте някои от създадените рамки. 
В полето "Preview" ще видите как ще изглежда вашата страница, ако изберете съответната рамка. 
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4. Нека да изберем рамка Contents. 
Ето как изглежда тя: 

 
5. След като натиснем бутонат "ОК" страницата добива следния вид: 

 
6. Натиснете бутоните "New Page" в двата фрейма за да направите нови страници. 
7. Сега въведете линкове към следните сайтове в първият фрейм: 
search.bg 
dir.bg 
gyuvetch.bg 
За да направим така, че тези линкове да се отварят във втория фрейм първо трябва да видим името му. 
8. За целта с десен бутон на мишката щракаме някъде в фрейма. След като се появи контекстното меню 
избираме бутона "Frame Properties". 
В последвалия диалогов прозорец Frame Properties от полето name копираме името на фрейма (main). 
А ако искате във вторият фрейм автоматично да се зарежда някоя страница, то в полето Initial page 
трябва да въведете линк към желаната страница. 

 
9. Време е да се върнем в първият фрейм и да модифицираме линковете. За всеки линк ще зададем да 
се отваря в фрейма с име main. 
10. След като маркираме вече посоченият линк, щракваме с десен бутон на мишката. От контекстното 
меню избираме бутона Hyperlinks properties. След като попаднем във вече познатия ни диалогов 

http://www.search.bg/
http://www.dir.bg/
http://www.gyuvetch.bg/
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прозорец "Insert Hyperlink" ( който сега се казва "Edit Hyperlink", защото напрактика вече имаме 
въведен линк) (виж. ХИПЕРВРЪКИ) избираме бутона Target Frame... 

 
В диалоговият прозорец Target Frame остава само да въведем името на втория фрейм (main) в полето 
target setting. Натискаме "ОК" и всичко е готово. 
 

http://lbulgaria.com/htmlpage/front%20page/hyperlinks.htm

